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Abstract

Actin filaments are essential for various biological activities in eukaryotic cellular processes. Available in vitro
experimental data on these systems often lack details and information on sample preparation protocols and
experimental techniques, leading to unreproducible results. Additionally, different experimental techniques and
polymerization buffers provide different, sometimes contradictory results on the properties of these systems, making
it substantially difficult to gather meaningful data and conclusive information from them. This article presents a
robust, accurate, detailed polymerization protocol to prepare high-quality actin filament samples for light scattering
experiments. It has been shown to provide unicity and consistency in preparing stable, dispersed, aggregates-free,
homogenous actin filament samples that could benefit many other scientific research groups currently working in
the field. To develop the protocol, we used conventional actin buffers in physiological conditions. However, it can
easily be adapted to prepare samples using other buffers and biological fluids. This protocol yielded reproducible
results on essential actin filament parameters such as the translational diffusion coefficient and electrophoretic
mobility. Overall, suitable modifications of the proposed experimental method could generate accurate, reproducible
light scattering results on other highly charged anionic filaments commonly found in biological cells (e.g.,
microtubules, DNAs, RNAs, or filamentous viruses).
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Actin filaments (F-actin) are highly charged double-stranded semiflexible polyelectrolytes formed by the
polymerization of G-actin subunits. Due to their hydrodynamic, mechanical, and electrostatic properties, these
cytoskeleton filaments have the extraordinary ability to dynamically change conformations in response to alterations
in G-actin concentration and type of crosslinker/binding proteins, as well as electrolyte concentration. These
cytoskeleton properties are crucial for eukaryotic cells to achieve specific biological functions in different cellular
compartments, which may vary depending on the cell type and location conditions. While a substantial amount of
research has been done in the biochemistry and biophysics fields (Lanni and Ware, 1984; Janmey et al., 1986, 1994;
Hou etal., 1990; Kas et al., 1996; Xu et al., 1998; Bonet et al., 2000; Niranjan et al., 2001; Y. H. Wang and Narayan,
2008; Crevenna et al., 2013; Del Rocio Cantero et al., 2020), the underlying principles and molecular mechanisms
that support the hydrodynamic, electrostatic, and stability properties of these filaments remain elusive (Lanni and
Ware, 1984; F. Wang et al., 1989; Hou et al., 1990; Kas et al., 1996; Bonet et al., 2000).

Modern dynamic light scattering (DLS) and electrophoretic light scattering (ELS) instruments are the most
accurate, non-invasive, experimental techniques to characterize hydrodynamic and electrostatic properties of
polydisperse charged biomolecules even at low concentrations and using small sample volumes. These instruments
use advanced technology and multi-functional software to measure the hydrodynamic size, polydispersity,
dispersion stability and aggregation, biomolecular charge, and zeta potential of particles and polymers immersed in
aqueous biological environments. To assure high accuracy and reproducibility of the results, it is essential to use
high-quality samples, accurate instruments, robust software, and optimized measurement protocols.

This article presents a complete, accurate, detailed polymerization protocol to prepare high-quality actin filament
samples for light scattering experiments. Obtaining actin filament samples that are stable, dispersed, clean from
aggregates and impurities, and homogenous could benefit many other scientific research groups in the field. We
describe the polymerization procedure for three typical actin buffers in physiological conditions (Janmey et al., 1986,
1994; F. Wang et al., 1989). Nevertheless, this protocol can easily be adapted to prepare samples using other buffers
and biological fluids. Additionally, we provide a unique methodology based on fundamental biostatistical tools
(McDonald, 2009) and a measurement protocol with optimized configuration to perform DLS and ELS experiments
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on actin filament samples at critical G-actin concentrations. We measured actin filament’s translational diffusion
coefficient and electrophoretic mobility using the same sample and experimental conditions for both DLS and ELS
experiments to assure unicity and consistency in the results (Alva et al., 2022). A fitting approach was adequate to
characterize other filaments’ essential properties, such as asymmetric length distribution, effective electric charge,
hydrodynamic size, effective diameter, dispersion stability, aggregation, and semi-flexibility (Kroy and Frey, 1997;
Tassieri et al., 2008; Alva et al., 2022). Additionally, the comparison of the light scattering results obtained for
different polymerization buffers elucidated the impact of their chemical composition, reducing agents, pH values,
and ionic strengths on the hydrodynamic, electrostatic, and stability properties of these actin structures. This kind
of comparison and characterization provides a deeper understanding of how actin filaments behave in various
cellular environments and conditions. Overall, suitable modifications of the proposed experimental method might
allow other scientific groups to obtain accurate and reproducible light scattering results on other highly charged
anionic polyelectrolyte filaments, commonly found in biological cells (e.g., microtubules, DNA, RNA, or
filamentous viruses), having hydrodynamic, electrostatic, and stability properties resembling those characterizing
actin filaments (Janmey et al., 2014).

Materials and Reagents

1. 2 mL glass vial (Agilent, catalog number: 20097845)

2. Polypropylene centrifuge tube, 15 and 50 mL (Corning, catalog number: 430791)

3. Polypropylene microfuge tube, 11 x 38 mm, 1.5 mL (Beckman Coulter, catalog number: 9080511)
4. 12 mm square polystyrene cell cuvettes (Malvern Panalytical, number: DTS0012)

5. 2 mL cryogenic vials (Corning, catalog number: 30721070)

6. Business source stainless steel scissors (Fiskars, catalog number: 01-004250J)

7. Optifit pre-sterilized tips, 10-1,000 pL (Sartorius, catalog number: PR151159)

8. Optifit pre-sterilized tips, 5-350 pL (Sartorius, catalog number; PR149531)

9. Quartz spectrophotometer cell rectangular, stopper, 1 mm (Starna Cells, catalog number: 21Q1)
10. Actin protein (>99% pure): rabbit skeletal muscle; store at 4 °C (Cytoskeleton, catalog number: AKL99)
11. Water for molecular biology (Millipore, catalog number: H20MB1001)

12. Calcium chloride, dried, powder, 97% (CaCl,) (Alfa Aesar, catalog number: 10219230)

13. Magnesium chloride, anhydrous, 99% (MgCl.) (Alfa Aesar, catalog number: W07D102)

14. Potassium chloride (KCI) (VWR, BDH Chemicals, catalog number: 18J2256059)

15. Tris base (Fisher Bioreagents, catalog number: BP152-500)

16. Beta-mercaptoethanol, molecular biology grade (BME) (Millipore, catalog number: 3192024)

17. Adenosine triphosphate (ATP), 100 mM stock (Cytoskeleton, catalog number: BSA04)

18. DL-Dithiothreitol (DTT), molecular grade (Promega Corporation, catalog number: 0000383224)
19. Sodium hydroxide, pellets, 97%, A.C.S. reagent (NaOH) (Sigma-Aldrich, catalog number: 1310-73-2)
20. HCI volumetric standard, 0.1 N solution in water (Sigma-Aldrich, catalog number: 7647-01-0)

21. Precision red protein assay reagent (Cytoskeleton, catalog number: ADV02)

22. 5 3/4” pipets (Fisherbrand, Fisher Scientific, catalog number: 13-678-20A)

23. 70% v/v denatured ethanol solution (Fisher Bioreagents, catalog number: 216731)

24. Orion buffers pH 4.01, pH 7.00, and pH 10.00 (Thermo Scientific, catalog numbers: YX1, YW1, YX1)
25. Universal dip cell kit (Malvern Panalytical, catalog number: ZEN1002)

26. 50 mM CacCl; (see Recipes)

27. 50 mM MgCl; (see Recipes)

28. 1.0 M KCI (see Recipes)

29. 102.24 mM KCI (see Recipes)

30. G-actin buffer 1 (pH 7.80) (see Recipes)

31. G-actin buffer 2 (pH 7.66) (see Recipes)

32. G-actin buffer 3 (pH 8.23) (see Recipes)

33. Polymerization buffer 1 (pH 7.56) (see Recipes)

34. Polymerization buffer 2 (pH 7.64) (see Recipes)
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35. Polymerization buffer 3 (pH 8.07) (see Recipes)
36. Electrolyte buffer 1 (pH 7.72), buffer 2 (pH 7.66), and buffer 3 (pH 8.06) (see Recipes)

Equipment

No o~ wNE

Analytical Explorer Pro-Scale (Ohaus Industrial Scales, model: PX84)

Pipette+ (Sartorius, Andrew Alliance Stand+)

Smart electronic pipettes: 5-350 pL, 10-1,000 pL, 5-10 mL (Sartorius, Andrew Alliance Stand+)

Vortex mixer with standard tube head, 120V (Corning LSE, The Lab Depot, Ref:6775)

Magnetic stirrer RT Basic-12 (Thermo Scientific, catalog number: 88880007)

Orion Star A211 pH meter, accuracy: + 0.002 (Thermo Scientific, catalog number: X56954)

Allegra 64R benchtop centrifuge machine (Beckman Coulter, product number: 367585) with a F1202 Rotor,
30,000 rpm (Beckman Coulter, catalog number: 19U3138)

8. Zetasizer ULTRA, accuracy MW: + 10% typical, temperature accuracy: 0.1 °C (Malvern Panalytical, model:
ZsSU5700)

9. Cary 100 UV-Vis spectrophotometer, accuracy: ~2% (Agilent Technologies, product number: 10069000)

Software

1. ZS Xplorer software (Malvern Panalytical, https://www.malvernpanalytical.com/en/products/product-
range/zetasizer-range/zetasizer-advance-range/zetasizer-ultra)

2. Microsoft Word 2021 (Microsoft, https://www.microsoft.com/)

3. Cary WinUV Kinetics (Agilent Technologies, https://www.bioprocessonline.com/doc/cary-winuv-software-
0001)

4. Cary WinUV Scan (Agilent Technologies, https://www.bioprocessonline.com/doc/cary-winuv-software-0001)

Procedure

A. ATP reconstitution

Briefly centrifuge to collect the white powder at the bottom of the storage tube.
Add 1 mL of cold 100 mM Tris base at pH 7.5 to reconstitute the ATP at 100 mM.
Aliquot the ATP into experiment-sized amounts as needed.

Snap frozen the ATP using liquid nitrogen.

. Store at or below -20 °C.

Notes:

a. The lyophilized ATP (desiccated to <10% humidity) is stable for six months at 4 °C.
b. The ATP is stable for six months if stored at or below -20 °C.

SAREEE I
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Figure 1. Experimental instrumentation and timeline.

(A) Daily timeline. (B) Workplace area and instrumentation. (C) Electronic Pipette+ OneLab, which reduces
errors and assures consistency across many tests. (D) The protein solution is transferred to the cell cuvette and
placed into the Zetasizer ULTRA holder to begin the diffusion coefficient measurements. (E) Subsequently, the
dip cell (ZEN1002) is introduced into the Zetasizer ULTRA holder to perform ELS experiments and obtain the
electrophoretic mobility, as well as the phase and frequency shift data plots.

B. Protein reconstitution

Notes:

a. Muscle actin is a liable protein; it should be handled with care.

b. To avoid repeated thawing cycles, consider specific experimental sized amounts.

c. Some of the steps considered in this section are recommended by the producer (Cytoskeleton, Inc). In
addition to those, we considered the addition of mixing steps (B3 and B5), due to the rapid
agglomeration/aggregation of the actin as the buffer is continuously added. Thus, we aim to achieve an
aggregate-free solution by considering the following: as actin should be handled with care, the vortex
speed is set at low to medium speed (4/10) for a short amount of time. Pipetting should also be carefully
handled to avoid high mechanical stress in the protein solution.

d. This step is performed on Day 3 (Figure 1).

e. The aliquots containing the protein and G-actin buffers are stable for six months at -80 °C.

1. Transfer the protein powder into a 3 mL glass vial.

2. Add 100 pL of ultra-pure water into the glass vial containing the protein powder to reconstitute at
10 mg/mL G-actin density.

3. Vortex the solution for 30-40 s at low to medium speed (4/10) to dissolve the protein powder as much as
possible.

4. Add 2.4 mL of G-actin buffer (buffers 1, 2, or 3—Recipes section B) to the glass vial containing the protein
solution.

5. Vortex one more time for 35-45 s at low to medium speed (4/10) to dissolve the aggregates as much as
possible. If aggregates are still present, pipette and mix the solution to achieve a homogeneous protein
solution.

6. Aliquot the solution into experimental sized amounts according to the number of experiments needed.

Transfer the small-size solutions into cryotube vials. We recommend aliquoting the protein solutions into
multiples of 250 pL (1x250 pL, 2x250 pL, 3%x250 uL, ...).
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7.

Once the wanted protein solutions are aliquoted, snap-freeze the cryotube vials with liquid nitrogen and
immediately store at -80 °C.

C. Actin polymerization

Notes:

a ATP and DTT are initially stored at -20 °C. When ready to prepare the solutions, thaw both solutions.
Immediately after use, snap-freeze them and store them back in the freezer.

b.  Following the manufacturer’s recommendation, after the 2 h centrifuge process, remove the top 90% (198
uL) of the supernatant from each microcentrifuge tube by following step C11. The amount of translucent
pellet left in the microcentrifuge will be 22 L.

C This step is performed on Day 4 (Figure 1).

d Atimeline for the actin polymerization steps can be seen in Figure 2.

1. Extract one of the cryotube vials containing 1x250 pL of protein solution from the -80 °C freezer.

2. Wait 5 min for de-frosting at room temperature.

3. Incubate the vial on ice for 1 h to depolymerize actin oligomers that form during storage.

4. Extract 200 uL from the cryotube vial and transfer to a 1.5 mL polypropylene microcentrifuge tube.

5. Add 20 pL of polymerization buffer (1/10" volume) (buffers 1, 2, or 3—Recipes section C) to the
microcentrifuge tube containing the 200 uL protein solution to start polymerization.

6. Vortex the solution for 40-50 s at low speed (3—4/10).

7. Incubate the protein solution at room temperature for 1 h.

8. Turn on the centrifuge 10-15 min before the previous step is finalized. Set up the centrifuge at
50,000 x g for2 h at 4 °C.

Note: The acceleration and deceleration should both be set at very low (2/10) speed.

9. Centrifuge the protein solutions for 2 h.

10. Carefully remove the tubes containing the actin protein solutions from the centrifuge and place them on
ice.

11. Set the 5-350 pL Pipette+ in titration mode at very low speed (1/10) and extract the supernatant from the
solution in the following manner, to avoid any possible stress in the solution that could lead to the breakage
of the actin filaments: 100 pL, 50 pL, and 48 pL.

12. Using the same Pipette+ specifications as in the previous step, add 978 uL of electrolyte buffer (buffers 1,
2, or 3—Recipes section D) to the actin protein pellet (22 pL).

13. Store the solution at 4 °C and leave it overnight.
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Figure 2. Activation, nucleation, elongation, and annealing of actin filaments.

(A) Hourly polymerization timeline of F-actin, starting with the incubation of actin protein at room temperature
and the addition of the polymerization buffer. After one hour, the centrifugation process begins to separate the
supernatant from the pellet (F-actins), and finally, the electrolyte buffer is added. (B) G-actin monomers
undergo a polymerization process that starts with the activation. In this step, Mg?*, K*, and Ca?* bind to G-actin
monomers reducing its electrostatic repulsion between monomers and inducing a structural change. (C)
Subsequently, the nucleation begins, where G-actin monomers form stable nucleus due to the presence of ATP-
and ADP-actin, supporting the addition of more monomers. (D) During the elongation stage, monomers are
rapidly added to the nucleus through both ends of the filament (pointed and barbed end). (E) Finally, in the
annealing step there is an association and dissociation of G-actin monomers at both ends of the filament.

D. UV-Vis spectrophotometer absorbance

Notes:

a. Turn on the UV-Vis spectrophotometer 10-15 min before use.

b. Determine the protein concentration in the supernatant with the precision red protein assay reagent. The
goal is to obtain the protein concentration in the pellet and after adding the electrolyte buffers. For more
information, see the Data analysis > Protein Concentration Analysis.

Pipette 1 mL of precision red protein assay reagent into a 1.5 mL disposable microfuge tube.

Add 10 plL of the supernatant protein solution obtained in step C11 and mix by inverting.

Incubate at room temperature for 1 min.

Transfer the solution into the quartz cuvette.

Set the Scan Controls at 0.100 s for Ave Time, 0.12 nm for Data Interval, and 100 nm/min for Scan Rate.
Blank the spectrophotometer on precision red protein assay reagent at 580-620 nm and read the absorbance
of the protein sample at 600 nm.

IR

E. Dynamic light scattering

A measurement consists of several averaged normalized intensity autocorrelation decays, called runs, each
lasting 10 s. The number of runs can be determined automatically by the software, based on the scattered light
intensity, which depends on the concentration and size of the macromolecule. Alternatively, it can be entered
manually by the user. For F-actins, the number of runs is typically five (see more details under Data analysis).
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1. Instrument start-up
Turn on the computer.
Turn on the Zetasizer ULTRA by pressing the power switch located on the back of the instrument.
The status light on the Zetasizer ULTRA will initially be red.
Open the ZS Xplorer software.
The status light on the Zetasizer ULTRA will become green shortly after.
. Wait 10-15 min for the instrument to stabilize.
2. Standard operating procedure (SOP)
a. Select Analyze > select Explorer > select Project Explorer ‘+’ sign > type the name of the new project.
b. Select Measure (see Figure 3)
i. Name: Type a sample name for this measurement.
ii. Cell: Select DTS0012
iii. Material: Select Protein
iv. Dispersant: Select Water
v. Project: Select the project created in step 2a.
vi. Measurement type: Select Size and 5 runs
vii. Measurement
1) Temperature: Select 25 °C
2) Return to default temperature: Select Yes
3) Equilibration time (s): Type 180
viii. Data Processing
Analysis Model: Select General Purpose
ix. Advanced Settings
1) Angle of Detection: Select Back scatter
2) Positioning Method: Automatically selected as Measure at a fixed position
3) Cell Position: Automatically selected as 5.50
4) Attenuation: Select Automatic
5) Measurement Process: Select Automatic
6) Use pause after sub runs: Select No
7) Optical Filter: Select No filter
8) Pause between repeats (s): Type 0
3. Sample preparation for measuring translation diffusion coefficient and correlation functions:

a. Remove the 1 mL aliquots of polymerized F-actins (buffers 1, 2, or 3—Recipes section B) from the
4 °C fridge and bring to room temperature for 10-15 min.

b. In the meantime, clean and sterilize the scissors with water and ethanol. Cut Optifit tips up to a
diameter of 3-5 mm from the tip. This action will greatly reduce the breakage of filaments when
transferring the aliquot into a cell cuvette.

c. The cell cuvette must be clean (air pressure) and free of scratches since this could lead to erroneous
measurements.

d. Setthe Pipette+ (5-350 pL) in titration mode at low speed (1-2/10) to extract the protein solution into
the cell cuvette. Titrate the protein at a 45° angle mode. The cell should be filled slowly at a 45° angle
to avoid creating air bubbles.

e. Do not fully cap the cell. Fully cap only one side of the cell. This action will also reduce the presence
of air bubbles during measurements.

f.  Open the cell area lid by pressing the button in front of the lid. Push the cell cuvette into the cell holder
until it stops. The small triangle at the top of the cell indicates the front of the cell, which should be
facing towards the user. Close the cell area lid.

g. During the measurements (every two sets of five runs), open the lid, remove the cell cuvette from the
cell holder, and mix the protein solution 2-3 times using a cut tip of 3-5 mm in diameter. Immediately
after, place the cell cuvette back in the cell holder and proceed to the next set of experiments. This
action will minimize sedimentation.

m® o0 o
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Measure ) Measure A

Figure 3. Zetasizer ULTRA.

(A) The DLS and ELS Zetasizer ULTRA instrument uses a 633 nm He-Ne laser. It houses a single cuvette and
measures light scattered at 173°, 90°, and 17°. It is interfaced to a computer running Windows 10 and controlled
with the Zetasizer software. (B) SOP window for ELS measurements. The settings shown here are also
presented under the ELS SOP (step I11). (C) SOP window for DLS measurements. The settings shown here are
also presented under DLS SOP (step H2).

4. DLS measurements

a. When the project and specifications are set and the sample is loaded, begin the measurements. Click
the Play bottom icon located by properties selection, and the initial green light of the Zetasizer ULTRA
will turn blue.

b. During DLS measurements, select Multi-view to display the following three windows: 1) “g(t)-1”
versus decay time “t,” which is updated as the run continues (see Figure 5); 2) the intensity
fluctuations described in Background; and 3) the intensity distribution.

c. As a series of runs accumulates into a measurement, select the Analyze tab and locate the Project
Name to get all the data generated by this measurement.

d. Aftereach run is over, the distribution function is calculated, and many data options are available such
as “Intensity vs. Size,” “Intensity vs. Volume,” and “Correlogram.” This process is repeated five times,
obtaining five similar correlation functions.

e. After the measurement is complete, the blue light will return to green, meaning that the Zetasizer
ULTRA is ready for the next set of measurements.

Electrophoresis light scattering

A measurement consists of several averaged fast field reversal phase shift, called runs, each lasting 1.4 s. The
number of runs can be determined automatically by the software, based on the scattered light intensity, which
depends on the concentration and size of the macromolecule. Alternatively, it can be entered manually by the
user. For F-actins, the number of runs is typically three (see more details under Data analysis).

1. Standard operating procedure (SOP)
a. Select Analyze > select Explorer > select Project Explorer ‘+’ sign > type the name of the new project.
b. Select Measure (see Figure 3)
i. Name: Type a sample name for this measurement.

Cite as: Alva, E. et al. (2022). In vitro Preparation of Homogenous Actin Filaments for Dynamic and Electrophoretic Light
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ii. Cell: Select ZEN1002
iii. Material: Select Protein
iv. Dispersant: Select Water
v. Project: Select the project created in step la.
vi. Measurement type: Select Zeta and 3 runs
vii. Measurement
1) Temperature: Select 25 °C
2) Return to default temperature: Select Yes
3) Equilibration time (s): Type 180
viii. Data Processing
Analysis Model: Select Auto mode
ix. Advanced Settings
1) Attenuation: Select Automatic
2) Measurement Process: Select Automatic with minimum runs set at 10 and maximum runs
set at 30
3) Use pause after sub runs: Select Yes and a pause duration (s) set at 10
4) \oltage selection: Select Automatic
5) Pause between repeats (s): Type 60

2. Sample preparation for measuring electrophoretic mobility, frequency, and phase shifts:

a.

Once the DLS measurements are over, remove the protein solution from the cell holder and proceed
to insert the dip cell (ZEN1002).

Before inserting the dip cell, its electrodes must be cleaned with ethanol and water. After every
measurement, the electrodes must be cleaned to reduce contamination across samples.

The dip cell must be placed into the sample cuvette. Place the ZEN1002 cell into the cell cuvette
containing the protein solution. Ensure that the small triangle at the top of the cell still faces the front
of the instrument, as indicated in section I. Make sure that the sample does not overflow the cuvette
when the ZEN1002 is fully inserted.

Holding the base of the ZEN1002 cell cap and the top of the cuvette simultaneously, push the cell into
the cell holder until it stops.

Open the cell area lid by pressing the bottom in front of the lid. Simultaneously holding the base of
the ZEN1002 cell cap and the top of the cuvette, push the cell into the cell holder until it stops. Close
the cell area lid.

During the ELS measurements, check the dip cell electrodes and sample for any potential
contamination. Failing to clean the electrodes after each run could lead to cross-contamination
between samples.

3. ELS measurements

a.  When the project and specifications are set and the sample is loaded, begin the measurements. Click
the Play bottom icon located by properties selection, and the initial green light of the Zetasizer ULTRA
will turn blue.

b. During ELS measurements, select Multi-view to display the following three windows: 1) “PALS:
phase(rad) vs t”, which is updated as the run continues (see Figure 6); 2) the intensity fluctuations
described in Background; and 3) the frequency shift.

c. As a series of runs accumulates into a measurement, select the Analyze tab and locate the ‘Project
Name’ to get all the data generated by this measurement.

d. After each run is over, the fast field reversal (FFR) of the phase analysis will be available along with
other data options such as the frequency shift.

e. After the measurement is complete, the blue light will return to green meaning that the Zetasizer
ULTRA is ready for the next set of measurements.

4. Shutdown

a. Exit ZS Xplorer software (File > Exit).

b. Turn off the Zetasizer equipment.

c.  Shut down computer.
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Data analysis

Detailed information on data analyses already appears in the “Materials and Methods” section of the original
research article (Alva et al., 2022).

A. DLS analysis

Note: The Backscatter angle technique significantly reduces the presence of dust in the signal-to-noise ratio
correlation plots. However, a wavering behavior can appear in the correlogram’ baseline due to multiple
exponential decays and an increase in the number of fluctuations. In that case, it may lead to aggregation and
sedimentation of the sample. Thus, we recommend following Note 12.

1. Once the set of measurements is completed, select the Analyze tab and select the appropriate project name
where all the measurements have been saved.

2. Select the Size tab. Under the data options, select the multiple parameters available for each run. For
instance, select Size > Z-average, PDI, translational diffusion coefficient, derived mean count rate, or any
other size parameter according to the user’s needs (see Figure 4).
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Figure 4. Table properties.

(A) Full display of available parameters and properties that can be selected according to the user’s needs for
DLS and ELS. (B) Selected and recommended parameters for DLS measurements. (C). Selected and
recommended parameters for ELS measurements.
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3. Once the chosen parameters are displayed, select the correlogram as one of the data plots to be displayed
for each run. The correlogram is an important data function for analyzing and determining the quality of
the sample and measurements. The correlograms must follow an experimental criterium to minimize errors
and assure reproducibility.

4. The correlogram plot’s intercepts must be under 1 and within a range in the low polydispersity index (0.4
< PDI < 0.8), indicating a good quality in the polydispersity samples.

5. The resulting derived count rate should be higher than 100 kpcs, the minimum value required to obtain
suitable measurements.

6. The correlogram plot should also present a smooth and uniform single exponential decay. However, the
correlogram data plots may show multiple exponential decays within a single run due to the sample’s
aggregates, sedimentation, and dust. In that case, the data is disregarded. This is also considered under the
experimental criterium to reduce error and increase reproducibility (see Figure 5).

Correlation Coefficient (g,-1)
Correlation Coefficient (gz-1)

a1 1 Lo Lo 1006 1000 100000 000D 10000300 X 1 1 w5 1m0 w0 000 la0seld 10000000

Time (ps) Time (ps)

Figure 5. Correlation coefficient.

Illustrative example of the correlation data function [g.-1 vs. time (us)] plots obtained from size measurements.
(A) Data measured from five consecutive, independent experiments. (B) The three correlation data functions
selected for data analysis after two measurements (2/5) are disregarded according to the experimental criterium
to increase accuracy.

B. ELS analysis

1. Once the set of measurements is completed, select the Analyze tab and the appropriate project name where
all the measurements have been saved.

2. Select the Zeta tab. Under the data options, select the multiple parameters available for each run. For
instance, select Zeta > zeta potential, electrophoretic mobility, quality factor, conductivity, or any other
electrophoretic parameter according to the user’s needs (Figure 4).

3. Once the chosen parameters are displayed, select the phase plot and frequency shift data plots to be
displayed for each run. The fast field reversal (FFR) phase plot is an important data function to determine
the quality of the sample and measurements. Three independent experiments were tested for each actin
filament sample to reduce statistical errors in electrophoretic mobility values.

4. The quality factor is a parameter that derives from the phase analysis plot during the FFR stage of the
measurement; it must be higher than 1 to be considered as good quality data.

5. The frequency shift plots should have very low traces of noise since this is another quality data check-up.
Also, the phase FFR plot should have a sinusoidal behavior, which also implies a good quality data (see
Figure 6).
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Figure 6. Phase and frequency shifts.

Iustrative example of phase and frequency shift plots obtained from electrophoretic measurements. Three
independent experiments are measured on the phase (A) and frequency shifts (B) to reduce statistical errors in
the electrophoretic mobility values. An evidence of good data quality is displayed in the frequency shift plot,
since there are no traces of noise and the curves match very well.

C. Protein concentration analysis

Note: We performed the calculation on the pellet concentration to confirm that the samples used in our
experiments were in the dilute regime, where the light scattering measurements correspond to single actin
filament properties. This condition is achieved when the pellet concentration value “c” = 1.37 uM is lower

than ﬁ * Ny, where <L> and Na are the average filament length and Avogadro’s number, respectively. Using
a fitting approach (Alva et al., 2022, Table 8), we obtained <L> ~0.5 um and ﬁ * Ny ~13.3 uM. Thus, our
experiments were performed in the dilute regime.
1. Calculation of initial concentration (Co)

a. When reconstituting the actin protein by adding 100 pL of ultra-pure water, the formulation is the

following:

Mass of Protein Powder (mg)

C(concentration) = =10mg/mlL

Volume
b. Adding 2.4 mL of G-actin buffer will change the concentration of protein to 0.4 mg/mL.:

1mg

C= 0imitzam - 04ma/mb

c. From each tube, we extract 200 uL and add 20 uL of polymerization buffer. Thus, the resulting initial
concentration of protein for experimental measurements is the following:

_ 0.08 mg
°70.2mL + 0.02mL

= 0.3636 mg/mL

2. Calculation of mass supernatant concentration (Msn) (Figure 7)
Note: In this stage, the spectrophotometric absorbance range is 0.009-0.012. This range comes from the
multiple independent measurements performed for all buffers. If the absorbance value is outside this range,
it is possible that a percentage of G-actins have not polymerized into filaments. In other words, the
centrifugation was incomplete and/or some excess protein concentration is found in the supernatant.
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Figure 7. Absorbance.

Ilustrative example of an absorbance data plot obtained from spectrophotometric measurements. The
absorbance curves for the total initial protein concentration (black line) and three independent experiments for
the supernatant were measured at 600 nm. The average absorbance value is used to determine the mass of the
supernatant in step C2 of Data analysis.

a. Theaverage of three independent absorbance values obtained for the supernatant at 600 nm is 0.01055.

b. Calculate the supernatant concentration based on 1.00 ODggonm = 100 pg protein per mL reagent per
cm and multiply this protein concentration by 10 to achieve the protein concentration in pg/mL of the
original protein solution.

c. The supernatant concentration is 0.1055 mg/mL in 198 uL. Thus, the following equation is applied to
solve for Msy:

Mgy = Supernatant Concentration * Supernatant Volume = 0.0209 mg

Calculation of pellet concentration (F-actin) (Cp)
a. First, the difference between the initial mass concentration (0.08 mg) and the mass of the supernatant
concentration (0.0209 mg) can be used to obtain the mass of the pellet, Mp, as follows:

Mp = Mass Initial Concentration — Mass Supernatant Concentration = 0.0591 mg

b. Furthermore, once the mass of the pellet (0.0591 mg) is known, the pellet concentration is easily
predicted in 22 pL (volume pellet):

Mass Pellet

~ Volume Pellet 2.687 mg /ml

P

c. Last, to find the molarity (M) of the pellet, we use the following equation where the pellet
concentration (mg/mL) is divided by the molecular weight of actin (43 KDa):

Pellet Molarity (M,) = Pellet Concentration(mg/mL) 137 uM
ertet Motarity WMe) = “Actin Molecular Weight (Da) #

Sample quality control
Note: The following steps/comments are intended for new experimenters to correlate the quality of their
samples to light scattering measurement data plots.
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a. The correlation function is an excellent indicative plot to ensure the system is free from
aggregation/sedimentation. As indicated in the DLS Analysis, if multiple exponential decays and
oscillated baselines are observed, it will most likely represent the sample’s aggregation and/or
sedimentation.

b. A good practice to ensure homogeneity in the sample is to mix and vortex the solution prior to any
DLS and ELS measurement to avoid the tendency to sedimentation and ensure good quality data.

c. Knowing the protein concentrations in the dilute regime is highly recommended to ensure dispersion.
If increased protein concentration is achieved, longer filaments and higher-order structures of actin
may be formed, leading to different results in the DLS measurements from those presented in our
article (Alva et al., 2022). From the ELS experiments point of view, high zeta potential values are
correlated with high repulsive forces between polymers, leading to a disperse system. If increased
polyelectrolyte concentration is achieved, zeta potential values may decrease, and the dispersion may
be weakened.

Notes

It is important to have good laboratory practices that include working in very clean conditions. To minimize
any source of contamination, tightly close tubes, vials, and samples. Make sure the cuvettes and vials are clean
and dust-free to prevent the presence of contaminants (see Figure 1).

The usage of a 15 mL conical tube was vital since it facilitated measuring and adjusting the pH of the buffers
(1-3). If the tube is smaller, the pH meter probe will not be able to fit; also, there will not be enough solution
to cover the tip of the probe leading to inaccurate pH readings.

When adjusting the pH (G-actin and polymerization buffers) use glass pipets to carefully add the base and acid
solutions drop by drop into the buffers. The addition of too many drops may increase or decrease the pH
significantly, so use caution. It is important to mix well by vortexing the solutions after adding these drops;
failing to do so will lead to inaccurate pH readings.

To begin the protein reconstitution, the 1 mg G-actin protein powder needs to be extracted. The powder is
usually frozen and stuck to the bottom of the vial. We suggest vortexing the protein vial at a low to medium
speed (5/10) for 30-45 s to smooth the protein powder and allow easy extraction when the protein is still dry.
After adding the G-actin buffer to the 10 mg/mL G-actin density, the protein will agglomerate. Mix the solution
well by vortexing and pipetting to lose the agglomerates. These structures are visible, so mix the solution well
to create and maintain a homogeneous solution.

G-actin proteins may concentrate at the solution’s surface. If so, mix the solution well before aliquoting into
experimental samples.

When cutting the Optifit tips using sterilized scissors, have a reference mark on the tips to make this process
easier and more consistent. The tips need to have a diameter of approximately 3-5 mm to reduce the breakage
of the filaments.

During the centrifugation step, we used a 50,000 x g spin for 2 h to ensure that short to long filaments pellet.
If a faster ultracentrifugation (50,000 x g < speed < 100,000 x @) is available, we recommend a duration of
1.5-2 h. If the ultracentrifugation is able to reach 100,000 x g, we highly recommend a duration of 1 h.

We recommend imaging actin filaments by fluorescent labeling of phalloidin and/or similar imaging techniques
such as transmission electron microscopy, to ensure the quality of actin final preparation and formation (see
Figure 8).

Cite as: Alva, E. et al. (2022). In vitro Preparation of Homogenous Actin Filaments for Dynamic and Electrophoretic Light
Scattering Measurements. Bio-protocol 12(22): e4553. DOI: 10.21769/BioProtoc.4553. 16



b|0-pr0t0C0| Published: Nov 20, 2022

B1-1_015

15 1um
Print Mag: 17500x @ 7.0 in HV=80kV
11:22 121512021 Direct Mag: 15000 x

UTHSCSA PATHOLOGY
Camera: XR80, Exposure: 800 (ms) x 2 std. frames, Gain: 1, Bin: 1
‘Gamma: 1.00, No Sharpening, Normal Contrast
1 —

Figure 8. Micrograph image of actin filaments.

Illustrative micrograph image of actin filaments using the JEOL 1400 transmission electron microscopy. During
the TEM sample preparations, the samples underwent a series of steps using 2% uranyl acetate on a formvar-
coated grid. The samples were washed 2—-3 times with distilled water.

10. WARNING: If the actin filaments or other polymers are exposed to high electrolyte salt concentrations (ionic
strength), there is a high possibility that new order structures (bundles and networks) and aggregates are formed
in solution. We recommend caution on the type and salt concentrations that are used in solution that could
induce bundles for actin filaments (Tang and Janmey, 1996) or other polymers.

11. Examples of different actin preparations:

a. At actin concentrations higher than the critical, the ATP-G-actin increases in solution leading to a
significant increase in the elongation rates (Crevenna et al., 2013) and the formation of longer and more
semiflexible filaments. As the length of filaments grows, the breakage of filaments may be higher. On the
other hand, longer filaments generate smaller diffusion coefficients and higher electrophoretic mobility
values.

b. The actin filament elongation kinetics depends on the pH solution. At pH higher than 7, shorter filaments
may be formed due to decreased elongation rates (Crevenna et al., 2013). Thus, a higher diffusion
coefficient and smaller electrophoretic mobility values would be expected at higher pH level solutions.

c. The polymerization rate depends on the type of divalent cation bound to actin. Thus, if Mg?* is used as
part of the polymerization buffer (instead of Ca?*), it could lead to changes in the mechanical and flexibility
properties of actin filaments (Steinmetz et al., 1997). These changes may affect the hydrodynamic and
electrostatic properties of actin filaments. Thus, changes in the diffusion and electrophoretic mobility
values may be expected when using different metal ions in the polymerization buffers.

d. High concentrations of Ca?* and Mg?* in the electrolyte solution may attenuate the repulsive inter-filament
interaction and the bundling formation of actin filaments (Castaneda et al., 2018). Thus, the actin
preparation under different divalent concentrations may generate actin bundles with different bending,
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diameter, and length, and consequently, hydrodynamic and electrostatic properties.

e. Capping proteins, namely gelsolin, regulate the assembly and length of actin filaments (Warshavsky et al.,
2022). For instance, the lower the ratio between G-actin and gelsolin concentration, the shorter the average
filament length, the higher the diffusion coefficient, and the smaller the electrophoretic mobility values.

To avoid sedimentation and/or aggregation of protein during light scattering experiments, gently pipette 2—-3

times the solution in between runs using the 3-5 mm cut tip.

If the sample has a higher protein and/or salt concentration than proposed in this protocol, we highly

recommend considering the viscosity parameter by adding this value in the ZS Xplorer software under Measure

> Dispersant.

The attenuation factor in the DLS instrument uses multiple positions (1-11) to control the beam intensity from

100% to 0.0003%. This feature was set to automatic to allow the ZS Xplorer software to determine the best

possible attenuator. For F-actins, the attenuation factor usually varies between 10 and 11.

The refractive index and absorption of the material have no bearing on the Z-average, polydispersity, and

intensity. We selected protein as the material being measured, consisting of a refractive index of 1.450 and an

absorption of 0.001. Similarly, the dispersant’s refractive index was set to 1.33, and viscosity to 0.8872 mPa-s.

These values may vary according to different materials and/or electrolytes being measured.

The correlation functions were measured at the back-scattering angle (173°), where the incident beam does not

have to travel through the entire sample. The effect of multiple scattering and dust is greatly reduced.

During DLS experiments, the measurement duration was automatically determined from the detected count

rate. The lower the count rate, the longer the measurement duration and the higher the noise.

Since F-actins form a polydisperse system of unknown size distribution, the general purpose analysis model

using the CONTIN algorithm was selected during the DLS measurements.

The ZS Xplorer software measures the sample electrical conductivity of the system when set as automatic. It

adjusts the cell voltage to keep a low current flowing, close to 5 ms/cm, in the sample. If this is not considered,

the sample temperature may increase near the electrodes, inducing bubble formation and sample degradation,
leading to inaccurate results.

The fast field reversal (FFR) of the phase analysis light scattering was selected since the mobility measured

during this period is due to the electrophoresis of the particles only. It is not affected by electro-osmosis

associated with the soft field reversal (SFR).

This protocol can also be applied for other manufacturer’s instruments such as Dynamics Mobius from Wyatt

Technology and NanoBrook Series from Brookhaven Instruments Corporation. Like ULTRA Zetasizer, these

instruments can perform DLS and ELS measurements. The software setup for both instruments is somewhat

similar, except the data analysis. We recommend the multimodal analysis for size measurements, specifically
for polydisperse systems.

The Mobius and NanoBrook Series instruments use different volumes and cuvettes for size and zeta potential

measurements. We highly recommend following their websites and manuals for usage of their cuvettes.

A time delay between measurements helped to reduce sample heating when long run measurements raised the

temperature of the cell to approximately 50 °C, allowing the sample to recover 25 °C between consecutive

measurements, reducing critical sample degradation and avoiding increasing mobility with sequential
measurements.

Standard operating protocol, data analysis (Parker and Lollar, 2021), and analysis of biomolecular preparations

to detect aggregation of proteins, glycoproteins, protein-protein complexes, and others, can be found elsewhere

(Stetefeld et al., 2016).
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Recipes
A. Stock buffers

1. 50 mM CaCl;

Reagent Final concentration Amount
CaCl, 50 mM 55.50 mg
H,O ultra-pure n/a 10 mL
Total 50 mM 10 mL
50 mM MgCl;

Reagent Final concentration Amount
MgCl, 50 mM 47.61 mg
H,O ultra-pure n/a 10 mL
Total 50 mM 10 mL
1.0 M KCI

Reagent Final concentration Amount
KCI 1.0M 7455 mg
H,O ultra-pure n/a 10 mL
Total 1.0M 10 mL
102.24 mM KCI

Reagent Final concentration Amount
KCI 102.24 mM 76.22 mg
H,O ultra-pure n/a 10 mL
Total 102.24 mM 10 mL

Notes:
1). To maintain the stock buffers biologically active, they need to be remade on a weekly basis.
2). This step is performed on Day 1 (see Figure 1).

B. G-actin buffers

1. G-actin buffer 1 (pH 7.80)

Reagent Final concentration Amount
Tris base (100 mM, pH 7.6) 2mM 100 puL
H,0 ultra-pure nla 4,845 L
CaCl, (50 mM) 0.2 mM 20 puL
ATP (100 mM) 0.5 mM 25 uL
DTT (100 mM) 0.2 mM 10 uL
Total n/a 5mL
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2. G-actin buffer 2 (pH 7.66)
Reagent Final concentration Amount
Tris base (100 mM, pH 7.6) 2mM 100 puL
H,0 ultra-pure nla 4,860 pL
CaCl, (50 mM) 0.2 mM 20 puL
ATP (100 mM) 0.2mM 10 pL
BME (50 mM) 0.1 mM 10 uL
Total n/a 5mL
3. G-actin buffer 3 (pH 8.23)
Reagent Final concentration Amount
Tris base (100 mM, pH 7.6) 2mM 100 puL
H,0 ultra-pure nla 4,830 uL
CaCl, (50 mM) 0.2 mM 20 puL
ATP (100 mM) 0.5mM 25 uL
DTT (100 mM) 0.5 mM 25 uL
Total n/a 5mL
Notes:

1). Calibrate the pH meter at three-point calibration using Orion buffers pH 4.01, 7.00, and 10.00 before its

usage.

2). To increase/decrease the pH, add drops of a base (0.74 M NaOH) or acid (0.1 N HCI) solution, respectively.
Add these drops carefully and constantly check the pH, as it can rapidly change.

3). This step is performed on Day 2 (Figure 1).
4). Have ice ready in a cooler, as all G-actin buffers must be done on ice.

C. Polymerization buffers

1. Polymerization buffer 1 (pH 7.56)

Reagent Final concentration Amount
H,0 ultra-pure nla 4,050 uL
MgCl. (50 mM) 2mM 200 pL
KCI (1.0 M) 150 mM 750 pL
Total n/a 5mL

2. Polymerization buffer 2 (pH 7.64)
Reagent Final concentration Amount
H,O ultra-pure n/a 4,050 uL
MgCl, (50 mM) 2mM 200 pL
KCI (1.0 M) 150 mM 750 pL
Total n/a 5mL

3. Polymerization buffer 3 (pH 8.07)
Reagent Final concentration Amount
H,0 ultra-pure nla 4,550 uL
MgCl, (50 mM) 2mM 200 pL
KCI (1.0 M) 50 mM 250 pL
Total n/a 5mL
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Notes:
1). This step is also performed on Day 2 (Figure 1).
2). Have ice ready in a cooler, as all polymerization buffers must be done on ice.

D. Electrolyte buffers

1. Electrolyte buffer 1 (pH 7.72), buffer 2 (pH 7.66), buffer 3 (pH 8.06)

Reagent Final concentration Amount
H,O ultra-pure n/a 10 mL
KCI 102.24 mM 76.22 mg
Total n/a 10 mL
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